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Introduction

This document is the RX110, RX111, RX113, RX130, RX231, RX23T Group RX Driver Package User’s Manual,
version 1.02.

This User’s Manual describes basic structures, features and usage of RX Driver Package applications, and about the
sample application program using the FIT modules included in this package.

Target Device

RX110 Group (Renesas Starter Kit RX110)
RX111 Group (Renesas Starter Kit RX111)
RX113 Group (Renesas Starter Kit RX113)
RX130 Group (Renesas Starter Kit RX130)
RX231 Group (Renesas Starter Kit RX231)
RX23T Group (Renesas Starter Kit RX23T)

When using this application note with your product, careful evaluation is recommended.

And when using this application note with other Renesas MCUSs, careful evaluation is recommended after making
modifications to comply with the alternate MCU.

Related Documents

¢ RX Family Board Support Package Module Using Firmware Integration Technology (RO1AN1685EU)
¢ Firmware Integration Technology User’s Manual (RO1AN1833EU)

o RX Family Adding Firmware Integration Technology Modules to Projects (ROLAN1723EU)

e RX Family Adding Firmware Integration Technology Modules to CS+ Projects (RO1IAN1826EJ)

e The User’s Manual provided with the RX Driver Package Application.
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RX Driver Package Ver.1.02

1. Overview

1.1 Applicability

This User’s Manual applies to the RX110, RX111, RX113, RX130, RX231, RX23T Group RX Driver Package, version

1.02.

1.2 Operating Environment
This package runs under the operating environment described below.

Table 1-1 Operating Environment (RX110)

Microcontroller

RX110 Group

Evaluation board

Renesas Starter Kit RX110

Integrated development
environment (IDE)

e? studio, V4.0.2 or later

Cross tools

RX Family C/C++ Compiler Package V2.03.00 or later

Emulator

El, E20

Table 1-2 Operating Environment (RX111)

Microcontroller

RX111 Group

Evaluation board

Renesas Starter Kit RX111

Integrated development
environment (IDE)

e? studio, V4.0.2 or later

Cross tools

RX Family C/C++ Compiler Package V2.03.00 or later

Emulator

El, E20

Table 1-3 Operating Environment (RX113)

Microcontroller

RX113 Group

Evaluation board

Renesas Starter Kit RX113

Integrated development
environment (IDE)

e? studio, V4.0.2 or later

Cross tools

RX Family C/C++ Compiler Package V2.03.00 or later

Emulator

El, E20

Table 1-4 Operating Environment (RX130)

Microcontroller

RX130 Group

Evaluation board

Renesas Starter Kit RX130

Integrated development
environment (IDE)

e? studio, V4.0.2 or later

Cross tools

RX Family C/C++ Compiler Package V2.03.00 or later

Emulator

El, E20

RO1AN3159EJ0102 Rev.1.02
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Table 1-5 Operating Environment (RX231)

Microcontroller RX231 Group

Evaluation board Renesas Starter Kit RX231

Integrated development e? studio, V4.0.2 or later
environment (IDE)

Cross tools RX Family C/C++ Compiler Package V2.03.00 or later

Emulator E1, E20

Table 1-6 Operating Environment (RX23T)

Microcontroller RX231 Group

Evaluation board Renesas Starter Kit RX23T

Integrated development e? studio, V4.0.2 or later
environment (IDE)

Cross tools RX Family C/C++ Compiler Package V2.03.00 or later

Emulator E1l, E20

RO1AN3159EJ0102 Rev.1.02
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2. About RX Driver Package

The RX Driver Package is a software platform (framework) that combines the following modules to be required for
development in a single package. Since the package contains multiple modules, you can start developing immediately

without having to obtain each module separately.

® Board Support Package (BSP) module

®  FIT peripheral function modules (free version)
®  FIT middleware modules (free version)
°

FIT interface modules

You can develop the user application layer with ease by using the Sample Application Program (RX Driver Package

Application) which utilizes the RX Driver Package.

2.1 System Structure
The figure below shows the system structure of the RX Driver Package.

RX Driver Package Application

e? studio
project
RX Driver |[ POSIX Wrapper ]
FIT Modul
Package (FIT Module)
1 I ! ! _
Middleware Middleware Device Driver e2 studio
L (FIT Module) (FIT Module) (FIT Module)
1 T 1 !
Device Driver Device Driver Device Driver Device Driver CC-RX
(FIT Module) (FIT Module) (FIT Module) (FIT Module) -
[ Interf ][M‘ddl ] i3 i | i ecc |
rerace e RTOS Wrapper * I.-'-'-'-'_'_'_T.
[ Toes ][ ] (FIT Meodule) L IAR }
X s Il 19 11 11— Jr | ||| S————--
Driver 1 I
’ - \
! RTOS !
Standard > 1
{ _(uITRON, FreeRTOS, etc) B Support
tool
P K . Board S rt P If i S
) oard Support Package
1
| optens 4 [ (BSP Module) )
-  ——— S | B
| Third party evaluation H Renesas evaluation E1. E20
L board H Board ' )

* Items marked with an asterisk are under development.

Figure 2-1 System Structure
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2.2 RX Driver Package Features
The RX Driver Package has the following features.

(a) Select necessary modules and start developing immediately the application program
You can easily build a system simply by selecting the modules you need from the package. After that, all you have to
do is develop the application program.

User System
(Server System)

Figure 2-2 An example of system build

(b) Freeto use
All the modules included in the RX Driver Package can be used free of charge. Free versions of middleware modules
such as TCP/IP and file system are included.

(c) Can upgrade to paid versions of modules

The free versions of modules in the RX Driver Package can be replaced with commercial (paid) versions. By using a
commercial (paid) version, all the functionality of the module will be available, as well as support about a commercial
version.

(d) Check operation including user application

The RX Driver Package Application is provided as a sample user application that uses the RX Driver Package. The RX
Driver Package Application consists of programs for operating each module in the RX Driver Package, and the project
files for building the programs. It enables you to start checking the operation of your user application immediately.

RO1AN3159EJ0102 Rev.1.02 Page 6 of 28
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3. Structure of the RX110, RX111, RX113, RX130, RX231, RX23T Group RX Driver
Package

3.1 Folder Structure
The folder structure used in this package is shown below.

When the ZIP file for this package is downloaded from the Renesas web site and decompressed, a folder of the same
name will be present and it will contain a FITModules folder, a reference_documents folder, and this document.

The FITModules folder contains the FIT modules for the modules shown in Table 3-1(as ZIP files and XML files).

The reference_documents folder contains the documentation for using this package in various development

|

RX110, RX111, RX113, RX130, RX231, RX23T Group RX Driver Package ZIP file
(an_r01an3159ej****_rx.zip)

l

an_r01an3159ej**** rx_fit

| _PDF_|
FITModules reference_documents Application Note

(r01an3159ej**** _rx.pdf)
| (This document)

1 1 |
v | = =

=
FIT Module XML FIT Module ZIP file Adding Firmware Integration Adding Firmware Integration
(r_***_y* % xml) (r_®**_y* %% z7ip) Technology Modules to Technology Modules
Projects to CS+ Projects

(rO0lanl1723*=xxxx_ry, pdf) (r0lanig2exxxxx*_rx. pdf)

Figure 3-1 Folder Structure of the RX110, RX111, RX113, RX130, RX231, RX23T Group RX Driver
Package
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3.2 Module Structure
The figure below shows the types and structure of the FIT modules included in this package.

Figure 3-2 RX110, RX111, RX113, RX130, RX231, RX23T Group RX Driver Package FIT Module
Structure
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3.3

FIT Modules

The table below lists the FIT modules included in this package.

Table 3-1 RX110, RX111, RX113, RX130, RX231, RX23T Group RX Driver Package FIT Modules

Type Module FIT Module R RRRRR Rev
Name X X X X X X
111122
1113 3 3
013 01T
Board Support Board Support Package (BSP) r_bsp v v v v vV 3.20
Package
Device Driver  Clock Generation Circuit (CGC) r_cgc_rx100 v v vo- - - 1.31
Device Driver  Low Power Consumption (LPC) r_Ipc_rx100 v v v o- - - 1.30
Device Driver  Battery Backup (VBATT) r_vbatt_rx - - - - V- 1.01
Device Driver  Interrupt Controller (IRQ) r_irg_rx v v v v VY 1.90
Device Driver  Data Transfer Controller (DTC) r_dtc_rx v v v vV 2.04
Device Driver  DMA Controller (DMAC) r_dmaca_rx - - - - V- 1.03
Device Driver  1/O Ports (GPIO) r_gpio_rx v v v v vV 1.80
Device Driver  Multi-Function Pin Controller (MPC) r_mpc_rx v v v v vV 1.90
Device Driver ~ Compare Match Timer (CMT) r_cmt_rx v v v - v - 2.60
Device Driver  Real-Time Clock (RTC) r_rtc_rx v v v - Vv - 2.40
Device Driver  Independent Watchdog Timer (IWDT) r_iwdt_rx v v vV vV o- 1.50
Device Driver  Serial Communications Interface (SCI: r_sci_rx v v v - vV 1.70
Asynchronous/Clock Synchronous)
Device Driver  Serial Communications Interface (SCI: Simple r_sci_iic_rx v v v v vV 1.80
I°C Bus)
Device Driver  I°C Bus Interface (RIIC) r_riic_rx v v v v vV 1.80
Device Driver  Serial Peripheral Interface r_rspi_rx v v v - Vv - 1.40
Device Driver  Serial Peripheral Interface (RSPI: Device Driver  r_rspi_smstr_rx v v v v vV 1.10
for Serial Memory Control)
Device Driver  USB Basic Firmware r usb_basic mini - v Vv - V - 1.02
Device Driver  USB Host Mass Storage Class r usb_hmsc_mini - v v - V - 1.02
Device Driver  USB Host Communication Device Class r_usb_hcdc_mini - Vv Vv - V- 1.02
Device Driver  USB Host Human Interface Device Class r_usb_hhid_mini - Vv Vv - V- 1.02
Device Driver  USB Peripheral Mass Storage Class r_usb_pmsc_mini - v Vv - V - 1.02
Device Driver ~ USB Peripheral Communications Device Class r_usb_pcdc_mini - Vv Vv - V- 1.02
Device Driver  USB Peripheral Human Interface Device Class r_usb_phid_mini - Vv Vv - V- 1.02
Device Driver  IrDA Interface (IrDA) r_irda_sci_rx - - v - - - 1.01
Device Driver ~ CAN Module (RSCAN) r_rscan_rx - - - - V- 1.00
Device Driver  12-Bit A/D Converter (S12AD) r_sl2ad_rx v v v - v - 2.10
Device Driver  D/A Converter (DAC) r_dac_rx VARVARVERNEINS 2.70
Device Driver  Flash Memory (Flash API) r_flash_rx v v v v vV 1.50
Device Driver  Serial Sound Interface (SSI) r_ssi_api_rx - - v - V- 1.20
Device Driver  LCD Controller/Driver (LCDC) r_lcdc_rx - - v - - - 1.00
Device Driver  Unique ID Read r_uid_rx v v v o- - - 1.00
Device Driver  Byte Queue Buffer (Data Management) r_byteq v vV v v vV 1.60
Device Driver  Long Queue Buffer (Data Management) r_longq vV v v v vV 1.60
RO1AN3159EJ0102 Rev.1.02 Page 9 of 28
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Type Module FIT Module R RRRRR Rev
Name X X X X X X
11112 2
1113 3 3
013 01T
Middleware TCP/IP M3S-T4-Tiny for Embedding r_t4 rx v v vV v v 2.05
Interface Embedded TCP/IP M3S-T4-Tiny Socket API r_socket_rx v v vV v Vv 1.30
Module
Middleware DHCP client using the embedded TCP/IP M3S- r_t4_dhcp_clientr v v - - - - 1.03
T4-Tiny Module X
Middleware DNS client using the embedded TCP/IP M3S- r t4 dns_clientrx v v - - - - 1.02
T4-Tiny Module
Middleware FTP server using the embedded TCP/IP M3S- r t4 ftp_server rx v V - - - - 1.03
T4-Tiny Module
Middleware Web server using the embedded TCP/IP M3S- r_t4 http_serverr v v - - - - 1.04
T4-Tiny Module X
Middleware Sound playback system and compression r_s2_rx - Vv v - Vv o- 3.03
system (original ADPCM codec)
Middleware M3S-TFAT-Tiny (FAT file system) r_tfat_rx - Vv v - V- 3.02
Interface M3S-TFAT-Tiny Memory Driver Interface r_tfat_driver_rx - Vv Vv - Y o- 1.02
Module
Middleware Simple 12C Module for EEPROM Access r_eeprom_sci_iic_ v v Vv - - - 1.30
rx
Middleware 12C Bus Interface (RIIC) Module for EEPROM r_eeprom_riic_rx v v v o- - - 1.40
Access
Middleware SPI Serial EEPROM Module r_eeprom_spi v v v v v Vv vV 233
Middleware SPI Serial Flash memory Module r_flash_spi v v v v v v Vv 233

Note: This package includes the M3S-T4-Tiny (TCP/IP protocol stack library) of evaluation version. For the
commercial version, please go to the below URL.
http://www.renesas.com/mwi/t4

RO1AN3159EJ0102 Rev.1.02 Page 10 of 28
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4. Usage Procedures

The RX Driver Package allows programs to be easily constructed by using the FIT plugin included in e studio. The
remainder of this section presents a simple usage example using e? studio. To use CS+, see the document “RX Family
Adding Firmware Integration Technology Modules to CS+ Projects (RO1AN1826EJ)” included in this package.

4.1 Environment Used

The RX231 is used as the target microcontroller and the Renesas Starter Kit RX231 is used as the target board. If a
different environment is used, replace the specifics used in the example with the ones for that environment as you read.

4.2 Install RX Driver Package in e? studio
Install the FIT modules in the RX Driver Package into e? studio.

1. Decompress the downloaded file an_r01an2670ej0101_rx.zip into an arbitrary directory.
2. Open the folder that was decompressed and open the FITModules folder in that folder.

3. Select all the files in the FITModules folder and click Copy in the Edit menu.

==jrn
S » FTModules » < [ |[[ Search FiModutes )
Eile| Edit [Wiew Iook Help
Organize v Include in library Share with v New folder 3~ 0 @
¥ Favorites o [T i i ol = o s ] DL 0 g nadich ) )
=gy iy il My vl mlben ] Select all files and click
4 =P I S R il il A il ] i ai ks T . .
- " 4 . -t Copy in the Edit menu.
B & L 1w Bl 1. Raviy_m ol T0.op e _o% e 7]
8 Computer o+ = e = i sl =T
“‘! Network W = |5
E8 Control Panel vk o SIS LR F -
3] Recycle Bin U = & L Lo o bl 5
W - P
1 el Bl e neagy el Kirp o 2 e 1 b
FlTMedules s M | =1 H
reference_documents i > | . e i
- - TNy =T 5 P L i _H i
- L b ALy et _elL H i
84 \htem;s
i
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4. Open the 2 studio install folder (Usually, this will be c:/Renesas/e2_studio.) and open the FITModules folder in

that folder.

5. Click Paste on the Edit menu.

The e? studio FITModules folder will be copied to the FIT modules.

[E=3 EoB === |
@Qv' » Computer » Local Disk (C:) » Renesas b €2_studio » FITModules » + [ #2 | search FiTModutes ) Open the FITModules
File| Edit [rew—Fool—tieip folder and click Paste
Organize ~ [ Open  New folder ) on the Edit menu.
- ' - The folder will be copied.
- = L
Renesas
rind ny . e :
. e2_studio i =
DebugComp 3 - _:
Drivers . . = .
eclipse '] " . ] 1 )
etc '] H&
FITModules = r
internal o |m = =
86 items selected
¢ Show more details.

4.3 Application Creation
In this section, create a simple application that drives an LED.

43.1 Create a Workspace and a Project
First, create a new workspace and a hew project.

1. Start e? studio.

2. Enter an arbitrary workspace folder in the displayed dialog box and click OK.

Workspace Launcher

Select a workspace

e2 studio stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session,

ﬂorkspace:| Chsample_ workspace I

[7] Use this as the default and do not ask again

=l
I ] Enter a workspace
) folder.
| ok H—eamee—] Click OK.

RO1AN3159EJ0102 Rev.1.02
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3. When the following window is displayed, click Workbench.

File Edit Source

igate Search Project

Views Run Window Help

@ Welcome 53

=
=

— Click Workbench.

4. When the workbench has started, select New from the File menu and click C Project.

Edit Socurce Refactor Mavigate Search Project Run Window Help

Click here.

New Alt+Shift+N » Renesas FIT Module
Open File... | | C Project I
= -
Close Ctrlew G+ Project
- . R
Close All CtrleShift<W Makefile Project with Existing Code
Y Project..
L] Save Ctrl+S ) :
B [savess.. Convertto a C/C++ Project (Adds C/C++ MNature)
[ Save Al CtitsShigtes | 85 | Source Fakder
S % Folder
[¢] SourceFile
Mo [ Header File
[ Rename.. = [ Filefrom Template
21 Refresh F5 & Class
Convert Line Delimiters To » & Task
= | Print... Ctrl+P E%  Other.. CirleN
Switch Workspace »
Restart
E2y Import..
B Export..
Properties Alt+Enter
Exit

r

RO1AN3159EJ0102 Rev.1.02
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5. Enter the project name. For the project type, click Sample Project under Executable (Renesas). For the tool chain,

click Renesas RXC Toolchain. After making these settings, click Next.
C Project III@

C Project f—

Create C project of selected type

Enter the

Project name| led_sample

Use default location
Chsample_workspacelled_sample Browse...

Create Directory for Project

project name.

Project type: Toolchains:
Executable (Renesas) KPIT GMUARM-RZ-EABI Toolchain
@® Sample Project KPR E-FHFootchain
Static Library (Renesas) KPIT GMURX-ELH Toolchain
@ Sample Project KPIT GNUSH-ELE Toolchain
Debug-Only Project Renesas RXC Toolchain)

Executable

Executable (TAR)

Shared Library

Static Library

V800 Standalone Executable (Green Hills)
VE00 Standalone Static Library (Green Hills)
V800 ThreadX Executable (Green Hills)
Makefile project

4 | n [

Renesas SHC Toolchain

Show project types and toolchains only if they are supported on the platform

@ cgack [ MNet> |[ Ensh ][ Cancel |

Click here.

6. Select the target. Click the “...” button under Target Selection and select R5F52318AxFP. After making these

settings, click Next.
C Project III@

e2 studio - Project Generation <

Select Target Specific Settings

Toolchain Version : [VZ.OI.CICI v] P
Debug Hardware: [E‘l v] "A@p
Data endian : [thtle-end\an data v] \‘\.{i‘

Click here and

L4
Select Target:
g ’;,4

Select Configurations:

Hardware Debug : Debug using hardware
Debug using Simulater : Debug using simulator
|| Release (no debug) : Project without any debug infermation

Build configurations will be created in the project only for the selected debug mode
options, however by default the project will be built for the active configuration i.e.,
first configuration selected from group. Based on the device selection you made
(RXG00) the debug hardware (E1) and debug target (RSF56107VxFP), debug
configuration will be automatically created for you.

select
R5F52318AxFP.

Click here.

RO1AN3159EJ0102 Rev.1.02
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7. Set the check box of “Use FIT module” and click Next here.

|| C Project
e2 studio - Project Generation

Code Generator and FIT Settings

Use Peripheral code Generator

== e |

se FIT module Download FIT moddles |

Set the check box

The e2 studie peripheral code generator automatically generates pregrams (device drivers) for MCU peripheral functions (clocks, timers, serial
interfaces, A/D converters, DMA controllers, etc.) based on settings entered via a graphical user interface (GUI). Functions are provided as application
programming interfaces (APIs) and are not limited to initialization of peripheral functions.
Conventionally, the information "CMCU initial settings’, "How to define a target board', "File configuration’, "Names of functiens’, "Coemmeon interface
with user application” etc; has in many cases varied by sample code, so changes needed to be made to sample code when embedding into a user
application. With FIT, there are rules for this information, so each sample code can be embedded into a user application with ease. Also, the peripheral
function drivers and middleware which support FIT have a common interface with user applications. This makes it easy to port user applications when

migrating between RX microcontrollers.

[ User Application

Middleware

CG
Device Driver

FIT

Device Driver (BSP)

[ MCU

@:' [ < Back

Next > |LL Finish

! Sancel I Click here.

8. Simply click Next here.

C Project
e2 studio - Project Generation
Select Additional CPU Options

Select Additienal CPU Options:

Round: [Nearest

Precision of Double: [Slngle precision

Sign of Char: [Unsigned
Sign of bit Field: [Unsigned
Allocate from Lower Bit [Luwer bit

Width of Divergence of Function: [24 Bit

Specify Global Options:

[] Denormalized number allowed as a result
|| Replace from int with short

[ Enum size is made the smallest

[ Pack structures, unions and classes

|| Use try, throw and catch of C++

[] Use dynamic cast and typeid of C++

Click here.

RO1AN3159EJ0102 Rev.1.02
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9. Simply click Next here.

C Project =0 ===

€2 studio - Project Generation —

Global Options Settings |

Patch code generation [None v]
Fast interrupt vector register: [None V]
ROM: [None ']
RAM: [None V]
Address (H'): 00000000

Address Register: [None v]

k) | T 1 = I
CJ [ < Back i[T s TT
10. Simply click Finish here.
|e? ¢ Project
e2 studio - Project Generation
Standard Header Files
Library configuration: | C[C32)
Select Header Files:
runtime : Runtime routines (Checked and disabled by default)

[ ctype.h : Character classification routines

[T math.h : Mathematical /trigonometric operations(double-precision)

[F] mathf.h : Mathematical /trigonometric operations(single-precision)

[Tl stdarg.h : Variable argument functions

[¥] stdie.h : Input/Output

[¥] stdlib.h : General purpose library features

[¥] string.h : String handling operations

[Cios{EC++) : Input/Output Streams

new(EC++) : Memeory allecation and deallecation routines

"] complex(EC++) : Complex number operations

|| string(EC++) : String manipulation operations

[Tl complex.h{€99) : Performs complex number calculation
[ fenv.h(ce9) : Sets floating point envirenment
[Tlinttypes.h(C98) : Converts integer type format

[T weharh(C99) : Performs wide character

[ wetype.h(C39)  : Performs wide character conversion

Select All || Deselect All

Click here.

|?|@

aocel ] Click here.
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11.Click OK. The project will be generated. .
Summary |E|

Project Summary:

———————— PROJECT GEMERATOR -------- -
PROJECT NAME : led_sample

PROJECT DIRECTORY : Ch\WorkSpace\RDP\led_sample
CPU SERIES :

CPUTYPE:

TOOLCHAIN MNAME : Renesas RXC Teolchain
TOOLCHAIN VERSION :

GEMNERATION FILES :

C\WorkSpace\RDP\led_sampletsrctled_sample.c
Main Program

4 3

Click OK te generate the project or Cancel to abort.

[ 0K 1|H Tancel ] Click here.
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4.3.2 Install the FIT Modules with the FIT Plugin.
Install the required modules with the FIT plugin into the created project.

Here, install the BSP module (r_bsp) and the compare match timer driver (r_cmt_rx).

1. Inthe Renesas Views menu, select e2 solution toolkit and click FIT Configurator.

7] C/Cer - e2studio =8| B8 55
File Edit Source Refactor Navigate Search Project [RenesasViews| Run Window Help
- [o-_-wiiplitE ez oo U R - BN SR S el A Quick Access |1 & | [E0/Gem )
Code Generator »
[ Project Explorer 53 BE% ¥=0 Debug = B = Outline 2 akeTa.. = O
> (B i) e ] €2 solution toolkit r»__;-y FIT Configurator Click here.
Partner 05 v | EL  Optimization Assistant An outline is not available.
Renesas 05 » | @ Smart Browser
[} Smart Manual

[#0 Preblems &2 Tasks Console operties emory Usage [fg] Stack Analysis Smart Browses = =8
0 items

Description Resource Path Location Type

(5 led_sample

AN =0 M Ee T = g

2. Inthe FIT Configurator tab,
Select the created project with Project to Add FIT Module to.
Next, select RX231 under Group and select RSKRX231 from Target Board.

Next, click r_cmt_rx in the module list and click Add Module >>.
[ C/Cev - e2 studic [= & [=]

File Edit Source Refactor Mavigate Search Project RenesosViews Run Window Help

I | ® [ Wi A O S @O RIS SR - - Quick Access || [ | [EEC/Ce+)
[ Project Explorer 3% = B8 = O  E= Outline 33 eTarget = B
EE ~

> =5 led_sample [HardwareDebug]

An outline is not available.

[2 Problems | Tasks [ Console [C] Properties [§l Memory Usage [kg] Stack Analysis & Smart Browser |75} FIT Configurator 52 | Generate Code  © = O

Narme of the project to add FIT modules: [[led_sample -]

Toge o R oJpeomsitien. S|ect the target board. SRR e

Available Modules

Selected Modules

Modules Version  Description || Modules Version

rbsp 300 Board Support Packages. El

Lbyteq 150 Byte-based circular buffer library.

r_combw 110 CATW Driver L.

r_cmt_m 260 Simple CMT driver for creating timer tick. I Se | ect th IS Item.

die 750 Digital-to-Analog Converter driver

r_dmaca_nc 103 DMACA driver

r_dtc_ne 203 DTC driver

r_eeprom_spi 232 Renesas R1EX25:w0c series Serial EEPROM control seftware RX Driver Package

cather o 10y Etharnat Rirber |
t=memeeweamer Click here.
Details

Dependency: r_bsp version(s) 290
This module creates a timer tick using a CMT channel based on a frequency input by the user,
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3. Inthe Console tab,
In the current example, the r_bsp having a dependency with r_cmt_rx is also added at a time. *
Click FIT Configurator again.

*: The r_bsp version defined in r_cmt_rx is 2.90 version or later. As r_bsp version packaged in the RDP is 3.20,
the Warning (W0000001) occurs on the console screen. However, as the Warning has no impact on adding the
module, it can be ignored.

|# Problems | Tasks | & Conscle &2 | [ Properties Memory Usage [&] Stack Analysis & Smart Browser [F5] *FIT Configurator =" | =~ *[j= = 0O
FIT Configurator Console
Meeeeeel: The following dependencies have been added for the following module: -
s —bopvers 228 Click here.
weeeeeel: The following dependencies versions are mismatched:
r_cmt_rx: r_bsp version(s) 2.9@

This is no problem to ignore this warning.

4. Check r_bsp and r_cmt_rx are added in Selected Modules. The mark “® on r_cmt_rx indicates occurrence of the
Warning explained in the above 3.
Then, click Generate Code.

|* Problems = Tasks [E Console [T] Properties Memory Usage [&] Stack Analysis @ Smart Browser | 1) *FIT Configurator &2 t5] Generate Code = = 5
\

Name of the project to add FIT modules: [\ed_sample \ v]

Torget Eoord [N ) Advonced Files.. Click here.
Available Modules Selected Modules
Modules Version  Description * || Modules Version
r_bsp 3.00 Board Support Packages. 3 r_bsp 3.00
r_byteq 1.50 Byte-based circular buffer library, B, r_cmt_rx 260
r_crbw_ne 1.10 CMTW Driver
r_cmt_m 260 Simple CMT driver for creating timer tick, \
r_dac_mx 2.50 Digital-to-Analog Converter driver Check here
r_dmaca_nx 1.03 DMACA driver
r_dtc_rx 203 DTC driver
r_eeprom_spi 232 Renesas R1EX25m0c series Serial EEPROM control software RX Driver Package
¢ athar e 102 Ethernet Neiar S
Add Medule > > << Remove Module
Details

Dependency: r_bsp version(s) 2.90
This module creates a timer tick using a CMT channel based on a frequency input by the user.
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5. Click OK with changing anything.
® FIT Generation - Summary

=

Follewing modules will be installed:
r_bsp
r_cmmt_rx

Follewing include paths will be added to project setting:
/8 ProjMNamel/r_bsp

/8{ProjName}/r_config

J8{ProjName}/r_cmt_rx

/8{ProjName}/r_cmt_rx/src

Click OK te continue, Cancel te go back

[ oK l|[ Cancel ] Click here.
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4.3.3 Create an LED Driving Program

Create a program that toggles the LEDO on/off state every 0.5 seconds using the compare match timer.

Open the file src/(the project name).c and modify it as shown below.

src/(the project name).c

#include "platform.h"
#include "r cmt rx if.h"

/* LED Currently status */
uint32 t ledstatus = LED_OFF;

void call back(void *pdata)
{
if (ledstatus ==

{
/* Turn ON the LEDO If the status is LED OFF */

LED OFF)

LEDO = LED_ON;
ledstatus = LED_ON;
}
else

{
/* Turn OFF the LEDO If the status is LED ON */

LEDO = LED OFF;
ledstatus = LED OFF;
}
}

void main (void)

{
uint32 t cmt ch;

/* LEDO off */
LEDO =LED OFF;

/* Create of 0.5 second(2Hz) cyclic timer. */

R CMT CreatePeriodic (2, &call back, &cmt ch);
while (1) ;
}
RO1AN3159EJ0102 Rev.1.02 Page 21 of 28
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434 Build and Try Running the Program
Build the program just created and verify that it runs.

1. Click Build Project on the Project menu.

2 studio

Search | Project | Run  Window Help

l : Dﬁ : Open Project
Close Project
= 8

-

Build All

=

Build Configurations

Ctrl+B
4

Build Project

Click here.

Build Working Set
Clean...

Build Automatically

Renesas Quick Settings

Make Target
C/C++ Index

Properties

Alt+Q

Update All Dependencies Alt+D

e LEDE 1

#5e
51

52

2. When the build completes, the following will be displayed in Console view.

WANE32.E, cmE_ch;

/* LED@ off

% 0

[5. Problems 2| Tasks [ Consele 57 [ Properties Memory Usage [ig] Stack Analysis

CDT Build Console [led_sample]

C:\Renesas\E22FCB~1\DEBUGC~1\RX\RX_CON~1.EXE led_sample.abs led_sample.x
Loading input file led_sample.abs

Parsing the ELF input file.....

25 segments required LMA fixes

Converting the DWARF information....
Constructing the output ELF image....
Saving the ELF ocutput file led_sample.x

'Build complete.’

17:31:13 Build Finished (tocok 195.594ms)

4 | 1

3. Click Debug Build on the Run menu.

Project Window Help

ZEF® R

*:, Debug
Run History
Run As

ot

Run Cenfigurations...

Debug History
Debug As

[RTRRT VYR ST FYR VTR FTINY

Ctrl+F11
F11

status i

Debug Cenfigurations...

———— Click here.

Toggle Breakpoint

Woh =D ca s oo

Teggle Line Breakpoint

AP
[

Toggle Watchpoint
23 | W Skip All Breakpoints
Removwe All Breakpoints

51 Breakpoint Types

% External Tools

Teggle Method Breakpoint

Ctrl+ Shift+B

status

b

3

[5: Problems =] Tasks ] Conscle 52 | = Properties Memory Us
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4. Click # under the Renesas GDB Hardware Debugging and click led_sample HardwareDebug. Click the
Debugger tab and click Connection Setting.
Modify EXTAL Frequency to be 8.0000 and change Provide Power from Emulator to No *.
When these changes have been made, click Debug.

Note : This is setting when using an external power supply. When supplying power from the emulator, select Yes.

Debug Configurations

Create, manage, and run configurations

TEX| B -

Name: led_sample HardwareDebug

)

type filter text |2 Main :’;}1 Debugger = Startup| B Source| 5] Common
[c7] Debug-only - )
-GDE Herd Debuoai Debug hacd £l x TargetDevice: Click here.
[c7 GDB Simulator Debugging (SH, RL7
kg GHS Local C/C++ Laungh GDE Settings| Connection Settings |[Debug Tool Settings
:¥ Renesas GDB Hardware fittach . Clock
Renesas GDB Hardware Pebugging Main Clock Source EXTAL g )
[c7] led_sample HardwareDebug Extal Frequency[MHz] |: L Modlfy to be
» [E9 Renesas Simulator Debugging (RX o Permit Clock Source Change On Writing Inte Ves - 8.0000.
4 Connection with Target Board
Ermulator (Auta) )
Cennection Type JTag -
ITag Clock Frequency[MHz] 16.5 -
Fine Baud Rate[Mbps] 2.00 -
Hot Plug Mo -
4 Power
Power Target From The Emulator (MAX 200n Mo M Od |fy to be NO .
Supply Voltage 3.3V -
4 CPU Operating Mode
Register Setting Single Chip -
Mede pin Single-chip mode -
4 Communication Mode
Mede Debug Mode -
Execute The User Program After Ending The [ Mo - -
4 . * [ Appl ] [ R
rt
Filter matched 9 of 13 items pply EVEl
@ [ peus [—e=— Click here.
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5. When the following message is displayed, click Yes.
Confirm Perspective Switch @

This kind of launch is configured to open the Debug perspective when it suspends,

This Debug perspective is designed to support application debugging. It
incorporates views for displaying the debug stack, variables and breakpeoint
management,

Do you want to open this perspective now?

["]Remember my decision

Click here.

6. When the load module download completes, a Debug perspective opens.

&7 Debug - led_sample/r_bsp/board/rsknddm/resetprg.c - &2 studio | =3 ECR()|
File Edit Source Refactor MNavigate Search Project Run  Window Help
B [ B - K- N FOH-C- - Nk EHE S i i Nrm i 2 ol Hn e | Y Quick Access || B | @ cces [Fpebug
%5 Debug 52 Opv % @ &8I T = O 0= Variables 13 =g

4 [£7 led_sample HardwareDebug [Renesas GDB Hardware Debugging] % | ¢ ey ¥

4 52 led_samplex

i X Name Type Value >
4 f® Thread [1]1 (No thread info availzble) (Suspended : Signal : SIGTRAP: Trace/breakpoint trap)
= PowerON_Reset_PC() at resetprg,c122 0ffc017e8
¥ gdb
o GDB server
[ resetprg.c 52 = 8 8= Outline 27 = B8
Once thi lization is complete, the user's main() function is called. It should not return. . PELRE o % T
Arguments i none . " "
* Return value : none U hclibh
R R # BSP_DECLARE_STACK
ffcel7ed - void PowerON_Reset_PC(void) U platform.h
{ # PSW_init E
/* stack pointers are setup prior to calling this function - see comments above # PSWint
/* Initialize the Interrupt Table Register */ # FPSW.init
ffco17fs set_intb({void *)__ sectop("CSVECT")); ++ _INIT_I0LIB(void) : void
+ _CLOSEALLvoid): void
itialize the Exception Table Reg # m armstart_p nction(void) : void
Ffeer7ff set Extb((vmd ) __sectop("EXCEPTVECT") )5 i £ my_sw_warmstart_p nction(void) : void
‘i v ++ PowerON_Reset_PClvoid) : void .
E Console 57 | ¥ Tasks % Renesas Coverage Memory Usage (- Performance Analysis ( Profile 1% Real-time Chart @2 Trace ('} Visual Expression [Z Problems (3 Executables [J Memory =8
|GBEEE & e i
Ied sample HerdvareDsbug [Renssas GDE Herdvare Debugging] gdb
monitor set_io_access_width,Ri,1, d, d, 902b5-902bd, 902c6-902cd, 302ds -9024d, 90266-9022d, 9027690273, 90305-9030d, 90316-9031d,98326-9032d, 90336 -9033d, 963469034, 90.
monitor set_io_access_width,Ri,1, d,90376-5037d, d, b bd,983c6-903cd, 903d6-903dd ,983e6-963ed, 99376-903Fd, 09820-9085F, 0084890853, 96858, 91206-91.

moniter set_io_access_width,RW,1,91226-9122d,91236-9123d,91246-9124d, 91256 -9125d,91266-5126d,91276-9127d ,91286-9126d , 91296-9129d , 91 226-912ad , 912b6 -212bd, 912¢6-512cd, 912d6-912dd , 912¢6-912¢d , 21
monitor set_io_access_width,RN,1,91305-9130d,91316-9131d,91326-9132d,91336-9133d,91345-9134d, 9135691354, 91366-9136d, 91376-9137d,91385-9138d, 9139691394, 91336-913ad, 913b6-913bd, 913¢6-913¢d, 91

< i, T

7. Click Restart on the toolbar. The program will be executed and a break will occur at the start of the main function.

Debug - led_sample/r_bsp/board/rsknédm/resetprg.c - e2 studio
File Edit Source Refactor Mavigate Search Project Run  Window Help
=

L |8 ~& o | F 0 %0 &~ \[k]l—m+ Click here.

%5 Debug 2 Eb'%@‘@:ﬂw|ﬁ>
4 [t led_sample HardwareDebug [Renesas GDB Hardware Debugging]
a 1 led_samplex
a f Thread [1]1 (Mo thread info available) (Suspended : Signal : SIGTRAP:Trace/breakpoint trap)
= PowerON_Reset_PC() at resetprg.c:122 Oxffc017ed
o gdb
p| GDB server

[ resetprg.c 52

8. After the break at the start of the main function, click Restart on the tool bar again.
The project will be run and the program will iterate toggling LEDO with a period of 0.5 seconds.
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435 For location of the API information of each FIT module
For the API information of FIT module embedded in the project, refer to the doc folder of each FIT module folder.
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5. RX Driver Package Application

5.1 RX Driver Package Application Structure

The RX Driver Package Application is a sample application program provided so that users can use the RX Driver
Package easily. The RX Driver Package Application consists of an application program that operates using device
drivers and middleware included in the RX Driver Package and a project file for building that application. This allows
users to start evaluation quickly.

RX Driver Package Application

| | p}'ogrl al - I l gro;ect !He I

Figure 5-1 RX Driver Package Application Structure

Renesas plans to release a variety of types of this RX Driver Package Application in the future, such as system
programs that operate using a combination of multiple drivers and middleware and evaluation programs for independent
modules from the RX Driver Package.

For information of the latest RX Driver Package Application, refer to the “Products Supporting RX Driver Package
Application” shown in the following URL.

http://www.renesas.com/products/mpumcu/rx/child/fit.jsp

Network server Camera Audio player
and client control program (ADPCM)
. . Image and video
Device driver i
d Boot loader middleware control
evaluation program
program
] RX Driver Package
RX Driver Package Application

Figure 5-2 Types of RX Driver Package Application
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6. Supplement

6.1 Commercial Version of Middleware and Drivers Supporting FIT
A list of the commercial version (paid) Middleware and Drivers for RX family is shown below.

For the information of the latest commercial version (paid) Middleware and Drivers, refer to the page of the
Middleware and Drivers shown in the following URL.

Page of Middleware and Drivers: http://www.renesas.com/mw/

Table 6-1 list of the commercial version (paid) Middleware and Drivers for RX family

Commercial Version URL FIT
Compliant

TCP/IP for Embedding http://www.renesas.com/mw/t4 Available

M3S-T4-Tiny
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Website and Support

Renesas Electronics Website
http://www.renesas.com/

Inquiries
http://www.renesas.com/contact/

All trademarks and registered trademarks are the property of their respective owners.
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1.01 Oct 31, 2015 - Updated existing modules to latest modules.
Added RX110, RX111 and RX231.
Updated e2studio version and changed set-up procedure.
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RO1AN2670EJ0101.
1.02 Feb 29, 2016 Updated existing modules to latest modules.

Added RX130 and RX23T.

Changed document number from RO1AN2670EJ0101 to
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General Precautions in the Handling of MPU/MCU Products

The following usage notes are applicable to all MPU/MCU products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that
have been issued for the products.

1.

Handling of Unused Pins

Handle unused pins in accord with the directions given under Handling of Unused Pins in the manual.

— The input pins of CMOS products are generally in the high-impedance state. In operation with an unused pin
in the open-circuit state, extra electromagnetic noise is induced in the vicinity of LSI, an associated shoot-
through current flows internally, and malfunctions occur due to the false recognition of the pin state as an
input signal become possible. Unused pins should be handled as described under Handling of Unused Pins in
the manual.

Processing at Power-on

The state of the product is undefined at the moment when power is supplied.

— The states of internal circuits in the LSI are indeterminate and the states of register settings and pins are
undefined at the moment when power is supplied.

In a finished product where the reset signal is applied to the external reset pin, the states of pins
are not guaranteed from the moment when power is supplied until the reset process is completed.
In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function
are not guaranteed from the moment when power is supplied until the power reaches the level at
which resetting has been specified.

Prohibition of Access to Reserved Addresses

Access to reserved addresses is prohibited.

— The reserved addresses are provided for the possible future expansion of functions. Do not access these
addresses; the correct operation of LSI is not guaranteed if they are accessed.

Clock Signals

After applying a reset, only release the reset line after the operating clock signal has become stable.

When switching the clock signal during program execution, wait until the target clock signal has

stabilized.

— When the clock signal is generated with an external resonator (or from an external oscillator) during a reset,
ensure that the reset line is only released after full stabilization of the clock signal. Moreover, when
switching to a clock signal produced with an external resonator (or by an external oscillator) while program
execution is in progress, wait until the target clock signal is stable.

Differences between Products

Before changing from one product to another, i.e. to a product with a different type number, confirm

that the change will not lead to problems.

— The characteristics of an MPU or MCU in the same group but having a different part number may differ in
terms of the internal memory capacity, layout pattern, and other factors, which can affect the ranges of
electrical characteristics, such as characteristic values, operating margins, immunity to noise, and amount of
radiated noise. When changing to a product with a different part number, implement a system-evaluation test
for the given product.




Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for

the incorporation of these circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from the use

of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics does not warrant that such information is error free. Renesas Electronics

assumes no liability whatsoever for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of third parties by or arising from the use of Renesas Electronics products or

technical information described in this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or

others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. Renesas Electronics assumes no responsibility for any losses incurred by you or

third parties arising from such alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: "Standard"” and "High Quality". The recommended applications for each Renesas Electronics product depends on

the product's quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic

equipment; and industrial robots etc.

"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-crime systems; and safety equipment etc.
Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems, surgical
implantations etc.), or may cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality grade of each Renesas Electronics product before using it
in a particular application. You may not use any Renesas Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable for any damages or losses
incurred by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, especially with respect to the maximum rating, operating supply voltage

range, movement power voltage range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or damages arising out of the

use of Renesas Electronics products beyond such specified ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have specific characteristics such as the occurrence of failure at a certain rate and
malfunctions under certain use conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to guard them against the
possibility of physical injury, and injury or damage caused by fire in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including but not limited to

redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult,

please evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. Please use Renesas Electronics

products in compliance with all applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive. Renesas Electronics assumes

no liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or
regulations. You should not use Renesas Electronics products or technology described in this document for any purpose relating to military applications or use by the military, including but not limited to the

development of weapons of mass destruction. When exporting the Renesas Electronics products or technology described in this document, you should comply with the applicable export control laws and

regulations and follow the procedures required by such laws and regulations.
10.

1)

contents and conditions set forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as a result of unauthorized use of Renesas Electronics

products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) "Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-owned subsidiaries.

(Note 2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.

It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or otherwise places the product with a third party, to notify such third party in advance of the
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